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ВВЕДЕНИЕ 
 
При моделировании напряженно-деформированного состояния 

конструкций отдельные их части часто бывают связаны 
различными видами шарниров. Связи между частями могут 
являться простыми, как, например, равные перемещения в шарнире, 
а могут иметь и более сложное представление, например, 
моделирование включенных в модель жестких тел или 
кинематических связей, которые некоторым образом передают 
движение между деформируемыми телами.  Жесткие части модели 
могут моделироваться в среде ANSYS элементами MPC184 в форме 
стержней и балок, в то время как движущиеся части модели могут 
быть связаны посредством MPC184 в форме ползуна, сферического, 
цилиндрического шарниров или шарниром Гука. Для элемента 
могут вычисляться и выводиться усилия и моменты, действующие в 
связях. 

Тип используемой связи зависит от потребности применения. 
 

ОПИСАНИЕ ЭЛЕМЕНТОВ ТИПА ШАРНИР 
 
Цилиндрический шарнир (вращательное сочленение) и шарнир 

Гука широко используются в автомобильной промышленности, в 
робототехнике, биоинженерии и иных отраслях. Такой шарнир 
определяются двумя узлами. Далее накладываются кинематические 
ограничения, которые определяют относительное движение между 
этими двумя узлами. Эти кинематические ограничения создаются 
при помощи множителей Лагранжа. 

Элемент шарнира имеет шесть степеней свободы в каждом узле, 
определяющих шесть компонентов относительного движения: три 
относительных перемещения и три относительных поворота. 
Некоторые из этих компонентов могут быть ограничены 
кинематическими связями, соответствующими типу элемента 
шарнира, в то время как иные компоненты ограничений не имеют. 
При использовании шарнира Гука и цилиндрического шарнира два 
узла должны совпадать, и таким образом относительные 
перемещения являются нулевыми. Свойства линейной жесткости и 
демпфирования шарнира при необходимости могут зависеть от 
температуры. 
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Данные элементы пригодны для линейных расчетов и 
нелинейных задач с большими поворотами и (или) большими 
деформациями. 

При создании сферического шарнира нужно для элемента 
MPC184 использовать признак KEYOPT(1) = 5. Два его узла 

должны совпадать. Элемент 
сферического шарнира накладывает 
кинематическое ограничение так, что 
перемещения в двух узлах, 
формирующих элемент, являются 
идентичными. Степени свободы в 
виде поворотов, если таковые 
имеются, ограничений не имеют.  

 
 
 
 
При KEYOPT(1) = 6 для элемента MPC184 получим 

цилиндрический шарнир с двумя узлами. Два узла, образующих 
шарнир, должны иметь 
идентичные координаты. 

Цилиндрический шарнир 
имеет только одну степень 
свободы, которая является 
относительным поворотом 
относительно оси вращения.  

 
 
 
 

 
 
 
Повороты относительно двух других направлений запрещены. 
Продемонстрируем последовательность действий по созданию 

цилиндрического шарнира на следующем примере. 
 
 
 

Рис. 1. Геометрия сферического 
шарнира

Рис. 2. Геометрия цилиндрического 
шарнира
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РАСЧЕТ ДЕФОРМИРОВАННОГО СОСТОЯНИЯ 
КАТАПУЛЬТЫ С УЧЕТОМ БОЛЬШИХ ПЕРЕМЕЩЕНИЙ 

 
Постановка задачи 

 
Цель: построить модель катапульты согласно схемы, представ-

ленной на рис. 3, и произвести расчет с учетом больших пере-
мещений. 

 

 
 

Рис. 3. Схема конструкции катапульты 
 
Катапульта построена из стальных труб, наружным диаметром 

40 мм с толщиной стенки 10 мм и модулем упругости  материала 
2·105 Н/мм2. Коэффициент Пуассона материала равен 0,33. Пружи-
ны имеют жёсткость, равную 5 Н/мм.  

К катапульте будет приложена вертикальная нагрузка в 1000 Н 
таким образом, как показано на рис. 3. 

Все вычисления проводятся в следующей системе измерения: 
длина – мм, сила – Н,  давление – Н/мм2. 

При моделировании катапульты будут использованы следующие 
виды элементов: 

 Pipe (пустотелая труба); 
 MPC184 (шарнир); 
 Combin14 (пружина). 
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Подготовка задачи к решению 
 

Задание имени для проекта 
 
Utility Menu > File > Change Title ... 
Те же самые действия можно выполнить при помощи командной 

строки:    /title, Catapult  
 

Задание типа конечных элементов 
 
MainMenu>Preprocessor>ElementType>Add/Edit/Delete… 
 

 
Рис. 4. Окно Element Types 

Нажмите Add… (рис. 4). В появив-
шемся окне (рис. 5) выберите типы эле-
ментов. 

Выберите в левом столбце Pipe, в пра-
вом – 2 node 288. Нажмите Apply. Далее 
выберите в левом столбце Constraint, в 
правом – Nonlinear MPC 184 . Нажмите 
Apply. Затем выберите в левом столбце 
Combination, в правом – Spring-damper 14. 
Нажмите OK. 

 
 

 
 

Рис. 5. Окна Library of Element Types. Задание типов элементов 
 
В списке заданных типов элементов появятся элементы 

PIPE288, MPC184, COMBIN14.  
Те же действия можно выполнить при помощи командной строки: 
ET,1,PIPE288  
ET,2,MPC184  
ET,3,COMBIN14    
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Теперь определите особенности используемого шарнира. 
Для этого в окне Element Types выберите элемент Type 2 
MPC184 и нажмите Options… (рис. 6). В появившемся окне 
MPC184 element type options (рис. 7) укажите тип Revolute и 
нажмите OK. Далее задайте ось вращения: Z-axis revolute (рис. 8). 
Нажмите OK. 

 

 
 

Рис. 6. Окно Element Types 

 
Рис. 7. Окно MPC184 element type options. 

Задание типа шарнира 
 

 
 

 
 

Рис. 8. Окно MPC184 element type options. Задание оси вращения элемента 
 
Те же самые действия можно выполнить при помощи командной 

строки: 
KEYOPT,2,1,6 
KEYOPT,2,4,1 
 

Определение констант элементов 
 
Preprocessor>RealConstants>Add/Edit/Delete… 
 
В окне Real Constants нажимаем Add… В окне Element type for 

Real Constants выбираем COMBIN14 и нажимаем OK. В поя-
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вившемся окне Real Constants Set Number 1, for COMBIN14 зада-
ем жесткость пружины, равную 5 Н/мм, для параметра Spring con-
stant (рис. 9, 10). 

 

 
 

Рис. 9. Окно Element Type for Real Constants 
 

 
 

Рис. 10. Окно Real Constants Set Number 1, for COMBIN14 
 
Те же действия можно выполнить при помощи командной строки:    
R,1,5, , , , , , 
 
Задание вида сечения конечного элемента Pipe 2 node 288: 

 
Чтобы задать вид сечения элемента, следует предварительно 

создать секцию для данного типа элемента под номером 1 (рис. 11).  
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Затем нужно задать имя и параметры сечения (рис. 12). 
 
MainMenu>Sections>Pipe>Add… 
 

 
Рис. 11. Окно Add Pipe Section 
 

 
 
Рис. 12. Окно Add or Edit Pipe Section 

 
Имя секции – Sec_Pipe. Внешний диаметр трубы (Pipe diameter) 

– 40 мм. Толщина стенки (Wall thickness) – 10 мм. 
 
Те же действия можно выполнить при помощи командной строки:   
SECTYPE,1,PIPE, ,Sec_Pipe   
SECDATA,40,10,0,0,1,0,0,0, 
 

Задание параметров для шарнира 
 
Для того, чтобы с помощью двух узлов создать  элемент типа 

«шарнир», необходимо предварительно создать для него локальную 
систему координат. 

Определяем локальную систему координат по узлам 2, 5, 3 и 
присваиваем ей номер 11.  

UtilityMenu>WorkPlane>LocalCoordinateSystems>CreateLocal
CS>By 3 Nodes + … 
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В появившемся окне вводим через запятую 2, 5, 3 и нажимаем 
Apply (рис. 13). В новом окне задаем номер системы координат – 
11. Тип координатной системы оставляем Cartesian 0 (декартова 
система координат). Нажимаем OK (рис. 14). 

 

 
 

Рис. 13. Окно Create CS By 3 Nodes. 
Задание узлов для создания локальной 

системы координат 
 

 
Рис. 14. Окно Create CS By 3 Nodes. 
Задание номера локальной системы 

координат 
 

Ось абсцисс в определенной локальной системе координат 
направлена от узла 2 к узлу 5, ось ординат от узла 2 к узлу 3. 
Получена левая система координат. 

 
Те же действия можно выполнить при помощи командной строки:     
CS,11,0,2,5,3,1,1,  
 
Задаем тип секции для шарнирного соединения (рис. 15): 
 
MainMenu>Preprocessor>Sections>Joints>Add/Edit… 
 
Имя секции – Sec_Joint. Идентификационный номер секции – 2. 

Подтип секции шарнира – Revolute. Локальная система координат 
для узлов I и J – 11. 

 
Те же действия можно выполнить при помощи командной строки: 
SECTYPE,2,JOINT,REVO,Sec_Joints  
SECJOINT,,      11,      11  
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Рис. 15. Окно Create and Modify Joint Sections 
 

Задание свойств используемого материала 
 
MainMenu>Preprocessor>MaterialProp>MaterialModels> 
Structural>Linear>Elastic>Isotropic 

 
В появившемся окне введите 

следующие параметры для стали:  
Модуль упругости EX: 2E5  
Коэффициент Пуассона   
PRXY: 0.33  
 
 

 
 
 

 
Те же действия можно выполнить при помощи командной строки: 
MPTEMP,,,,,,,,   
MPTEMP,1,0   
MPDATA,EX,1,,2E+5    
MPDATA,PRXY,1,,0.33 
 
 

Рис. 16. Окно Linear Isotropic 
Properties for Materieal Number 1
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Создание узлов 
 
Preprocessor > Modeling > Create > Nodes > In Active CS... 
Для катапульты необходимо создать 13 узлов с координатами, 

представленными в табл. 1. В открытом окне (рис. 17) вводим по-
рядковый номер узла и координаты в соответствии с таблицей.  

 
Таблица 1 
Номер 
узла 

Координаты 
X Y Z 

1 0 0 0 
2 0 0 1000 
3 1000 0 1000 
4 1000 0 0 
5 0 1000 1000 
6 0 1000 0 
7 700 700 500 
8 400 400 500 
9 0 0 0 

10 0 0 1000 
11 0 0 500 
12 0 0 1500 
13 0 0 –500 

 

 
Рис. 17. Окно Create Nodes in Active 

Coordinate System 
 
 
 
 

 
Примечание: узлы 1 и 9, 2 и 10 имеют идентичные координаты. Это 

сделано для того, чтобы впоследствии задать с их помощью  элементы 
типа «шарнир». 

 
Те же действия можно выполнить при помощи командной строки: 
N,1,0,0,0,,,, 
N,2,0,0,1000,,,, 
 ( и аналогично для остальных узлов). 
 
Создание элементов типа Pipe 2 node 288 по созданным узлам 
 
Сначала нужно задать тип элемента и определить его атрибуты: 
 
MainMenu>Preprocessor>Modeling>Create>Elements> 
ElemAttributes… 
Выбираем тип элемента PIPE288, секцию – Sec_Pipe (рис. 18). 
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Рис. 18. Окно Element Attributes 
 
Примечание: в том случае, если для элемента указано имя секции, ко-

торая с ним ассоциирована, все вещественные константы игнорируются. 
 
Те же действия можно выполнить при помощи командной строки: 
TYPE,1 $ MAT,1 $ REAL,1 $ ESYS,0 $ SECNUM,1 $ TSHAP,LINE   
 
Создаем элементы типа Pipe по узлам, указанным в табл. 2: 
 
MainMenu>Preprocessor>Modeling>Create>Elements> 
AutoNumbered>ThruNodes… 
 

Таблица 2. Номера узлов для 
создания элементов типа Pipe 

Node a Node b 
1 6 
2 5 
1 4 
2 3 
3 4 

10 8 
9 8 
7 8 

12 5 
13 6 
12 13 
5 3 
6 4 

 

Так как выбрать узлы с помощью 
мыши в диалоговом режиме неудоб-
но (но возможно), то лучше исполь-
зовать командную строку следующе-
го вида:  

 
E, node a, node b 

где node a – номер первого узла из таблицы 2, 
node b – номер второго узла из таблицы 2. 

 
E,1,6 
E,2,5 

 
(и аналогично для остальных эле-
ментов) 
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Рис. 19. Вид конструкции с отображенными 

номерами узлов 
 

Примечание: на рисунке 
отображена конструкция ката-
пульты, состоящая только из 
элементов Pipe. Пружины и шар-
ниры ещё не созданы. 

 

Создание элемента типа шарнир 
 
Сначала нужно задать тип элемента и определить его атрибуты: 
MainMenu>Preprocessor>Modeling>Create>Elements> 
ElemAttributes… 
 
Выбираем тип элемента MPC184, секцию – Sec_Joint (рис. 20). 
 

 
 

Рис. 20. Окно Element Attributes 
 
Те же действия можно выполнить при помощи командной строки: 
TYPE,2 $ MAT,1 $ REAL,1 $ ESYS,0 $ SECNUM,2 $ TSHAP,LINE   
 
Создаем элементы типа шарнир по узлам: первый шарнир – узлы 

1 и 9, второй – узлы 2 и 10: 
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33
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8
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8

7
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3
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4
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MainMenu>Preprocessor>Modeling>Create>Elements> 
AutoNumbered>ThruNodes… 
 

 
 

Рис. 21. Окно Elements from Nodes. Создание шарниров 
 
Те же действия можно выполнить при помощи командной строки: 
E,1,9                   
E,2,10  

 
Рис. 22. Вид элемента типа шарнир 

В месте создания шарнира 
появляется точка (рис. 22). 

 

 
Создание элементов типа пружина 

 
Сначала нужно задать тип элемента и определить его атрибуты: 
 
MainMenu>Preprocessor>Modeling>Create>Elements> 
ElemAttributes… 
 
Выбираем тип элемента COMBIN14, набор констант – 1, секцию – 

No section (рис. 23). 
Примечание: для того чтобы значения вещественных констант не бы-

ли проигнорированы, необходимо указать, что с этим элементом нет ассо-
циированных секций. 
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Рис. 23. Окно Element Attributes 
 
Создаем элементы типа пружина по узлам: первая пружина –  

узлы 5 и 8, вторая пружина – узлы 8 и 6: 
 
MainMenu>Preprocessor>Modeling>Create>Elements> 
AutoNumbered>ThruNodes… 
 
Те же действия можно выполнить при помощи командной строки: 
E,5,8 
E,8,6 
 

1

6

2

5

1
4

2
33

4

10

8

9

8

7

8
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5

13
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12

13

5
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RR                               19

RR                               210

5

88

6

11X

Y

Z

 
 

Рис. 24. Вид окончательной конечно-
элементной модели конструкции катапульты 

Окончательный вид 
модели представлен на 
рис. 24.  
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Нумерация элементов 
 
UtilityMenu>PlotCtrls>Numbering… 
Отмечаем Node numbers и выбираем Element numbers в выпа-

дающем списке Elem/Attrib numbering (рис. 25). 
 

 
 

Рис. 25. Окно Plot Numbering Controls 
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Рис. 26. Вид конструкции катапульты 
с отображенными номерами элементов 

 

 
Просмотр конструкции с отображением вида сечений 

 
UtilityMenu>PlotCtrls>Style>Size and Shape… 
 

 
 
Рис. 27. Окно Size and Shape 

 

K0                              
K0                        

11X

Y

Z

15:03

 
Рис. 28. Объемное изображение 

конструкции катапульты 
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Задание нагрузок и решение 
 

Задание типа анализа (Статический анализ) 
 
Solution > Analysis Type > New Analysis > Static 
 
Те же действия можно выполнить при помощи командной строки: 
/SOL 

ANTYPE,0 
 

Учет больших перемещений 
 
Solution>Sol’nControls>Вкладка Basic 
 

 
 

Рис. 29. Окно Solutions Controls 
 

Задание ограничений на перемещения в соответствии 
с расчетной схемой 

 
Запретим перемещение для узлов 3, 4, 12, 13 по всем степе-

ням свободы. 
 
Solution > Define Loads > Apply > Structural > Displacement > 

On Nodes… 
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Выберите узлы 3, 4, 12, 13 и нажмите APPLY (рис. 30).  
В появившемся окне выберите степени свободы ALL DOF и на-

жмите OK (рис. 31). 
 

 
 

Рис. 30. Окно Apply U, 
ROT on Nodes

 
Рис. 31. Окно Apply U, ROT on Nodes. 

Запрет перемещений по всем степеням свободы 

 
Задание силы 

 
Solution>Loads>Apply>Structural>Force/Moment>OnNodes… 
 
Выберите узел 7 и нажмите APPLY. 
Задайте вертикальную силу 1000 Н. 
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Рис. 32. Окно Apply F/M on Nodes 
 
Для отображения граничных условий: 
UtilityMenu>PlotCtrls>Symbols… 
 

 
 

Рис. 33. Окно Symbols 
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В результате получим такое изображение: 
 

1

K0                              

K0                              

11 X

Y

Z

                                                                                

OCT 29 2012
15:15:13

ELEMENTS

U
ROT
F

 
 

Рис. 34. Вид конструкции катапульты после задания нагрузки 
 

Решение задачи однократного анализа 
 
Solution > Solve > Current LS 
 
Примечание: в процессе решения появляется предупреждение «Coeffi-

cient ratio exceeds 1.0e8», которое показывает, что решение имеет большие 
перемещения. Это связано с шарнирами.  

 
По окончании решения видим следующее окно, где отображается 

процесс сходимости решения в зависимости от итераций (рис. 35)  
 

 
 

Рис. 35. Сходиммость решения 
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Рис. 36. Вид конструкции катапульты 
после расчета приложенной нагрузки 
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Те же действия можно выполнить при помощи командной строки:   
SOLVE 

 
Просмотр результатов 

 
Отображение деформированного состояния катапульты 

 
GeneralPostproc>PlotResults>DeformedShape>Def + 

undeformed>OK 
 1

K0                              

R

R

11X

Y

Z

O
DISPLACEMENT

STEP=1
SUB =3
TIME=1
DMX =384.145

 
 

Рис. 37. Вид деформированной и недеформированной конструкции катапульты 
 

Просмотр значения скалярнного параметра vert 7 
(то есть перемещения  UY узла 7) 

 
Чтобы найти вертикальное перемещение узла 7, используйте ме-

ню 
UtilityMenu>Parameters>GetScalarData… 
Создайте переменную с именем vert 7 (скалярный параметр) 

(рис. 38). 
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Рис. 38. Создание скалярного параметра vert7 
 

Для отображения заданного параметра выберите: 
UtilityMenu>Parameters>ScalarParameters… 
 

 
 

Рис. 39. Окно Scalar Parameters 
 

Просмотр анимации 
 
UtilityMenu>PlotCtrls>Animate>ModeShape… 
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Рис. 40. Окно Animate Mode Shape 
 

Использование сферического шарнира в конструкции 
катапульты 

 
Понятно, что для получения таких же результатов можно ис-

пользовать тип элемента MPC184 Spherical (сферическ ий шарнир). 
Для этого при выборе типа элемента укажите: 
 

 
 

Рис. 41. Окно MPC184 element type options 
 
Задайте параметры для сферического шарнира: 
MainMenu>Preprocessor>Sections>Joints>Add/Edit… 
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Рис. 42. Окно Create and Modify Joint Sections 
 
В тексте командного файла следует лишь заменить выделенные 

строки на одну:  
 KEYOPT,2,1,15  !тип элемента MPC184 - spherical 
 

Сохранение командного файла 
 
Выберите Utility Menu > File > Write DB Log File...  
В появившемся окне напишите имя командного файла, например 

‘katapulta.txt’. Нажмите OK.  
Если вы откроете командный файл в текстовом редакторе, таком 

как Notepad, то он будет выглядеть примерно так: 
 
! Катапульта 
! Выбор типа  элементов 
/PREP7                ! Вызов препроцессора 
/TITLE, Catapult      ! Название задачи 
 
! Задание  типов элементов 
ET,1,PIPE288          ! Элемент  PIPE 16 (для трубы) 
ET,2,MPC184      ! Элемент MPC184 (для шарнира)  
ET,3,COMBIN14         ! Элемент COMBIN 14 (для пружины)  
KEYOPT,2,1,6 !тип элемента MPC184 – revolute joint 
KEYOPT,2,4,1 !вращение вокруг оси UZ 
SECTYPE,1,PIPE, ,Sec_Pipe   !создание секции для трубы 
SECDATA,40,10,0,0,1,0,0,0,  !задание геометрических пара-

метров для трубы 
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R,1,5, , ,        ! Задание  Real Constants для элемента 
типа 3 (COMBIN 14) 

 
! Задание свойств материала 
MPTEMP,,,,,,,,                       
MPTEMP,1,0   
MPDATA,EX,1,,2E+5            !Модуль Юнга 
MPDATA,PRXY,1,,0.33          !Коэффициент Пуассона 
 
! Создание геометрии (  узлов по координатам ) 
N,1,0,0,0,,,,                       ! узел  1 
N,2,0,0,1000,,,,                    ! узел   2 
N,3,1000,0,1000,,,,                 ! узел   3 
N,4,1000,0,0,,,,                    ! узел   4 
N,5,0,1000,1000,,,,                 ! узел   5 
N,6,0,1000,0,,,,                    ! узел   6 
N,7,700,700,500,,,,                 ! узел  7 
N,8,400,400,500,,,,                 ! узел  8 
N,9,0,0,0,,,,                       ! узел  9 
N,10,0,0,1000,,,,                   ! узел  10 
N,11,0,0,500,,,,                    ! узел  11 
N,12,0,0,1500,,,,                   ! узел  12 
N,13,0,0,-500,,,,                  ! узел  13 
 
!  Активизация типа элемента  PIPE 288 
!  Задаем  его параметры   
TYPE,   1    
MAT,    1 
REAL,       1    
ESYS,       0    
SECNUM,  
TSHAP,LINE   
 
! Создание элементов  типа PIPE 288 по узлам  
E,1,6                                   ! элемент  1 
E,2,5                                   ! элемент  2 
E,1,4                                   ! элемент  3 
E,2,3                                   ! элемент  4 
E,3,4                                   ! элемент  5  
E,10,8                                  ! элемент  6 
E,9,8                                   ! элемент  7 
E,7,8                                   ! элемент  8 
E,12,5                                  ! элемент  9 
E,13,6                                  ! элемент  10 
E,12,13                                 ! элемент  11 
E,5,3                                   ! элемент  12 
E,6,4                                   ! элемент  13 



 28 

 
!создание локальной системы координат по узлам 
CS,11,0,2,5,3,1,1,  
 
 !задание локальной системы координат для элемента MPC184 
 
SECTYPE,2,JOINT,REVO,Sec_Joints  !создание  секции для 

шарнира 
 
SECJOINT,,      11,      11  !задание локальной системы 

координат для шарнира 
 
!  Активизируем  тип элемента  MPC184 и задаем  его пара-

метры 
 
TYPE,   2    
MAT,       1 
REAL,       1    
ESYS,       0    
SECNUM,   2  
TSHAP,LINE   
!создание элементов шарниров по узлам 
E,1,9                         ! элемент  14 
E,2,10                        ! элемент   15 
 
!  Активизация  типа элемента  COMBIN14 
!  Задание  его параметров 
 
TYPE,   3    
MAT,       1 
REAL,       1    
ESYS,       0    
SECNUM, ,    
TSHAP,LINE 
! Создание элементов типа COMBIN14 по узлам (пружина ) 
E,5,8                          ! элемент   16        
E,8,6                          ! элемент  17 
 
FINISH  ! Финиш  препроцессора 
 
/SOL                                                               
/GO         
! Задание закреплений в узлах 
! В узлах 3,4,12,13  все степени свободы запрещены 
            
D,3, ,0, , , ,ALL, , , , ,  
D,4, ,0, , , ,ALL, , , , ,  
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D,12, ,0, , , ,ALL, , , , ,  
D,13, ,0, , , ,ALL, , , , ,   
/GO  
F,7,FY,-1000             ! Задание силы F= -1000 в узле 7        
 
! Решение задачи 
ANTYPE,0    ! Тип анализа - статический 
NLGEOM,1  ! Геометрическая нелинейность (большие деформа-

ции) 
SOLVE   ! Вызываем решатель 
FINISH  ! Финиш решателя 
 
! Вызов постпроцессора 
! Просмотр перемещений U узла 7 по оси Y  
/POST1   
PLDISP,1      
! Просмотр перемещений U узла 7 по оси Y   
GET,VERT7,NODE,7,U,Y 
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Варианты заданий 
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Двутавры 
 

№ Размеры, мм 

h b s t 
10 100 55 4.5 7.2
12 120 64 4.8 7.3
14 140 73 4.9 7.5
16 160 81 5.0 7.8
18 180 90 5.1 8.1

 
 

Труба 
 

№ Размеры, мм 
d t 

1 100 8 
2 120 10 
3 140 12 
4 160 12 
5 180 14 

 

Швеллеры 
 

№ Размеры, мм 

h b s t 
5 50 32 4.4 7.0

6.5 65 36 4.4 7.2
8 80 40 4.5 7.4
10 100 46 4.5 7.6
12 120 52 4.8 7.8
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